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ABSTRAK

PENGEMBANGAN GAME PERANG PESAWAT SPACE WING
MENGGUNAKAN VISUAL BASIC 6.0

Arisandy Sya’ban, NIM : 0512528
Doscn Pembimbing : M.Ibrahim Ashari,5ST.MT dan Sandy Nataly Mantja,S.Kom

Penciptaan dan modifikasi game komputer sebagai fasilitas untuk bermain ataupun
media hihuran semakin herkembang seiring dengan perkembangan teknologi serta inovasi.
Pengembangan game im berbasis pada ketertarikan animasi penampilan serta tingkat
kesulitan yang lebih tinggi dibandingkan dengan game yang sama pada versi lama.

Proses pengembangan game ini dimulai dari mempelajan dan menganalisis system
permainan game Space Wing versi lama kemudian menyusun dan membuat desain sistem,
membual alur permainan serla komponen — komponen lain yvang dibutuhkan. Proses
pembuatan program menggunakan bahasa pemrograman Microsoft Visual Basic 6.0,

Dengan adanya permainan game perang pesawal Space Wing ini penulis berharap
bahwa pengembangan game ini akan memberikan wacana baru tentang game dan
menambah pengetahuan penulis tentang cara mengembangkan suatu game.

Kata Kunci : Game,Visual Basic 6.0, Space Wing
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1.1

BAB 1
PENDAHULUAN

Latar Belakang

Salah satu permainan game komputer vang cukup menarik adalah game perang
pesawat, dimana dalam game ini perang pesawal lerjadi diluar angkasa melawan para
alicn dan pemain harus menghindari tabrakan langsung dari alien dan menembak alien
hingga hancur, ada beberapa tyvpe alien yang masing-masing memiliki karakter vang
berbeda, setelah menghancurkan alien - alien tersebut pemain akan berhadapan dengan
boss alien yang sangat kuat, pemain harus menjaga kesehalan pesawalnya agar
permainan tidak berakhir, bila pemain berhasil menyclesaikan misi, maka pemain akan

menuju pada level selanjuinya.

Visual Basic (sering disingkat sebagai VB saja) adalah merupakan sebuah bahasa
pemrograman yang menawarkan friegrated Development Environment (IDE} visual
untuk  membual program perangkat  lunak  berbasis sistem  operasi  Microsoft
Windows dengan menggunakan model bahasa pemrograman. Dengan menggunakan
Visual Basic maka setiap ohjek baik dalam bentuk gambar, movie, ataupun suara dapat
terorganisir dengan baik., dengan demikisn Visual Basic dapat digunakan untuk

menthuat game. 5

Berdasarkan uraian diatas, penulis bermaksud untuk mengembangkan game perang
pesawat Space Wing menggunakan Visual Basic 6.0, dari yang awalnya game ini hanya
berorientasi pada pencapaian skor lertinggi tanpa adanya level permainan sedangkan
dalam pengembangan gamc ini nantinya, penulis tidak hanya berotientasi pada
pencapaian skor akan tetapi menambahkan level permainan sehingga game manjadi
Icbih menantang dan juga dengan adanya penambahan karakter boss alien yang mampu

menghidupkan sisi menacik dari sebuah game.




1.2 Humusan Masalah
Berdasarkan latar belakang pemilihan judul, maka vang menjadi permasalahan
adalah bagaimana mengembangkan game perang pesawal Space Wing ini darl versi
sebelumnya vakni Black and White (tidak berwarna) kedalam versi saat sekarang yakni
2D (frell celor).

L3 Tujuan
Tujuan penyusunan skripsi ini adalah untuk pengembangan game perang pesawat
Space Wing verst Hondheld games (nintendo) menjadi menjadl PC Games (game
komputer) dengan menggunakan babasa pemrograman Visual Basic 6.0,

1.4 Batasan Musalah
Pada pembuatan game perang pesawal Space Wing ini, penulis membual ruang

lingkup pembahasan atau batasan masalah sebagai berikut

1. Imput dibalasai hanya pada kgpboard dan mouse sedangkan owutpur perangkat

lunak pada layar monitor,

[-d

Jumlah pemain satu (1) orang.

Dalam menu utama permainan mengeunakan bahasa Indonesia.

Dalam permainan lidak terdapat animasi prefoader saat pergantian level.
Level permainan sampai level lima (5).

Pemain hanya bisa memilih satu (1) pesawat.

=B e B

Tingkat kesulitan gawe rormal

1.5 Metodologi

Metode yang digunakan dalam pengembangan game perang pesawat adalah :

1. Mempelajari cara pecmbuatan game dengan Fisual Basic 6.1),
2. Mencari source code Viswal Bagic 6.0,
3. Menganalisa dan mempelajan cara permainan dari game Space Wing.

4. Merancang inferfece untuk game Space Wing.




1.6

[

Sistematika Penulisan

Pada penulisan tugas akhir ini terdiri atas lima pembahasan vaitu :

BABI

BABII

BABIII

BAB IV

BABYV :

: PENDAHULUAN

Bab ini merupakan pendahuluan dimana akan tercakup sccara umum
mengenai latar belakang penulisan laporan, ruang lingkup karya tulis ini,
wjuan dan manfaat yang mau dicapai, metodologi vang dipakai dalam

penyusunan laporan dan sistematika penulisan yang digunakan.

: LANDASAN TEORI

Bab ini berisi tentang teori-leon yang mendukung dan berhubungan
dengan  judul penulisan tugas akhir.

METODOLOGI

Bab ini berisi prosedur percobaan dan menjclaskan tentang metode
penyelesaian yang dilakukan.

IMPLEMENTASI DAN PENGUJIAN

Bab ini berisi penjelasan pembahasan  program  scsual  dengan
petinasalahan yang diambil dalam penulisan tugas akhir,

PENUTUP

Bab ini berisi kesimpulan dan saran dari penulisan tugas akhir.




BAB I1
LANDASAN TEORI

1 Sejarah Perkembangan Game
Bermain game bukanlah scsuatu yang asing, hingga kini telah banyak mesin-mesin
smutar gome ataw corsole yang mampu menampilkan game vang memukau, perkembangan
mme memang bepitu pesat seiting dengan perkembangan teknologi, inovasi tidak herhent
mpai disitu, perkembangan game juga merambah ke komputer, berikut sejarah perkembangan
JHE.
211 Game Generasi Perfama

Pada tahun 1952, di Universitas Cambridge Amenka Serikat, Douglas menulis
sebugh tesis untuk pelar sebuah PhD-nya mengenai interaksi antara computer dan
manusia, dalam tesisnya ilu ia menciptakan game computer dari sebuah permainan
tradizsional bernama Tic-Tac-Toe, game ini diprogram dengan memakai computer
EDVAC vacum mbe vang memiliki layver berupa cathode ray tube (CRT), kemudian
ditahun 1958, William Haginbhotam menciptakan video game pertama, berbeda dengan
douglas, video wame pertamanya yang berjudul Yennis for P'wo diciptakan dan dimainkan
di ascilioscope,

Akan tetapi game generasi pertama yang benar-benar diciptakan menggunakan
computer adalah spacewar, dimana apda tahun 1960-an computer adalah barang yang
hiasa dipakai untuk kepentingan risct dalam dunia militer, akan tetapi sesorang bernama
Steve Russel memiliki ketertarikan akan hal lain, bersama (eman-temannya Russel
membuat scbuah pame bermmama Spacewar yang lerinspirasi dari fiksi ilmiah berjudul
gkylark karangan Edward E Smith, kebetulan Steve Russel berkerja menggunakan schuah
computer mainframe bernama MIT PDP-1 yang biasa dipakai untuk perhitungan statistic.

dengan computer itulah dia membuat Spacewar ditahun 1961,




L

212 Game Generasi Kedua

Di tahun 1971, Nelan Bushnell bersama Ted Dabney menciptakan game
ber-genre arcade yang bernama Space. game tersebut didasari oleh Spacewar. tahun
1972 Nolan dan Ted wmulai membuat Atari  computer, kemudian dia
mengembangkan game berudul Pomg vailu game pertama yang lersedia unluk
public, karena game-game sebelumnya hanya ada dalam computer mainframe untuk
kesenangan sendiri saja. asal usul Pong dimulai saat Nolan ingin membuat game
sederhana dan mudah dimengerti, dengan memory dan micre processor kelas
rendah, kemampuan proses yang terbatas dan grafis sederhana, akhimya dia
membuat versi elektronik dari permainan ing Pong vang kemudian menjadi Posg.

Sedikit selingan, Pong kemudian berevolusi menjadi sebuah game bernama
Breakout, pame tersebut diciptakan oleh Steve Jobs untuk Atari, dari situ Steve jobs
dan temannva Steve Wozmak mulai berpikir unluk menciptakan scbuah PC,
kemudian mereka meminjam semua peralatan vang dipakai dalam provek Breakoul
dan membual Prefoppe bernama Apple | vang merupakan cikal bakal dari
compuler Apple Macintosh vang ada sekarang.

Pada tahun 1980, Atari mengeluarkan camc becjudul Asteroid dan Lunar
Lander, kedua game tersebul adalah game pertama yang didaftarkan pada kantor
hak cipta untuk mendapat hak paten, Asteroid merupakan game yang penuh inovasi
baru dalam grafisnya, dari pada menggunakan metode raster, pame ini merupakan
gratis vector line seperti yang ada pada oscilloscope.

Pengenalan Arari Video Computer System (Alarl 2600) dengan CPU biasa
dan slot untk kasetnya menjadi cra baru dalam dunia game, ditahun 1980 juga
menunjukan penjualan yang meningkat dari PC yang biasa dipakai uniuk game,
hingga kini computer bersaing dengan mesin konsol seperti PS dan XBOX, dan
computer tidak hanya sebagal mesin untuk kepentingan bisnis semata, lapi juga

urttuk hiburan seperti game.




2.2 Karakter Dalam Game

Salah satu clemen terpenting dalam game adalah karakter. karakter dalam game
memiliki pengaruh yang sangat kuat terhadap game, dimana dengan karakter tersebut
sebuah game dapat menjadi terkenal atau tidak. Contoh karakter yang menjadikan suatu
game lerkenal antara lain Super Mario pada semua sed game Super Mario, Sonic, Ray-
man, dan beberapa karakter pada game RPG terkenal seperti Final Fantasy, Shining Force
dan sebagainya.

Untuk membuat karakier yang menarik perlu mengetahui seni menggambar, baik ilu
menggambar secara manual maupun menggambar secara digital. Pada dasamya kedua cara
tersebut sama hanya saja media yang digunukan berbeda seria pengetahuan lerhadap suatu
dava desain. Berikut pembagian karakter berdasarkan gaya desain:

2.2.1 Gayu Realis Derail
Gaya inl biasanva ditangani oleh orang professional yang lelah mahir mengolah
gambar, selain it uniuk menangani gava realis vang detail. Flash mengalami
kesulitan karcna flash tidak memberikan efek shading (bavangan) dan flighting

{pencahayaan), meskipun dalam flash 8 terdapat efek Alur dan shadow, tetapi efek

tersebut tidak optimal untuk membuat paya realis dan detail, schingga dibutuhkan

software lain semacam Adobe Photoshop, Firework, Gimp atau sejenisnva.
2.2.2 Guya Realis Sederhuna
Gaya ini merupakan penyederhanaan dari gaya realis detail. Untuk membuatnva
dapat dilakukan proses fracing alau menjiplak sebuah pambar realis dan
mengurangi detailnya, Dalam gome [ash, gaya ini lebih banvak dipakai, karena
selain lebih mudah membuatnya, karakter vang tidak terlalu detml membuat movie
berjalan normal.
2.2.3 Gaya Kartun
Gaya ini merupakan penyederhanaan dan perubahan bentuk dari gaya realis
sederhana. Gaya kartun fetap memperiahankan svatu bentuk standar. Sebagai
contoh manusia memiliki kepala, badan, tangan dan kaki. Bentuk tersebut tetap

dipertahankan namun dengan proporsi dan penggavaan yang berbeda.




224  Gayva Imajinasi
Gaya ini bersifat bebas, tidak terikat dengan bentuk realis dan merupakan hasil
dari imajinasi pencipta game. Beberapa game flash menggunakan karakler bergaya
imajinasi karena selain mudah membuatnya, karakier bergaya imajinasi juga dapat
mempermudah dalam membentuk sebuah (muge (trademark) kepada publik.

2.3  Background Game
Selain karakter, dalam game juga dibutuhkan sebuah backpround atau latar
belakang, Membuat background dalam flash dapar dilakukan dengan beberapa cara seperti
pada pembuatan karakter. Berikul jenis-jenis backsround dalam game [lash,
2.3.1  Static Background
static Backgrowmd atan background diam sering digunakan pada game flash.
Selain mudah membuatnya, static hackground tidak membutuhkan seripi khusus
untuk menggerakannya. Perhatikan contoh dari game yang menggunakan sratic
background bertkut.

2.3.2  Scrolling Background
Rerbeda dengan staric background yang diam, hackground bertipe serolling

bergerak dari kanan ke kiti, atas kebawah atau sebaliknya. Tingkat kesulitan dari
pembuatan scrolling backeround adalsh pengolahan senpl, karena tanpa scripl yang
baik, movie tidak dapat berjalan sesuai vang diharapkan. Perhatikan contoh dari
game yang menggunakan serolling background berikut.
233  Paralux Buckground

Paralax hackground adalah background berlapis, dimana background yang
lebih dekal dengan mata pemain, bergerak lebih cepat dari background yang jauh
dari mata pemain. Selain menambah kesan kedalaman, perambahan paralax
backpround dapat menambah kesan realis suvatu game. Untuk membuat paralax
background pada game harus membuat minimal dua lapis backgrownd dengan

kecepatan yang berbeda, perhatikan gambar berikut




234  Random Buckground
Pada dasarmya rarndom background sama seperti hackground scrolling,
hanya saja random buckeround berjalan secara acak, baik itu dari sisi kanan ke kiri,

atas kebawah ataupun sebaliknya.

24 Animusi

Animasi merupakan salah satu bagian grafika komputer yang menyajikan tampilan-
tampilan yang sangal atraktif juga merupakan sekumpulan gambar yang ditampilkan secara
berurutan dengan cepat untuk mensimulasi gerakan vang hidup. Pemanfaatan animasi dapat
ditujukan untuk simulasi, menarik perhatian pemakai komputer pada bagian tertentu dari
layar, memvisualisasikan cara kerja suatu alat atau menampilkan keluaran program dengan
pgambar-gambar vang menarik dibandingkan dengan sederetan angka, serta tidak
ketinggalan untuk program-program permnainan,

Pada dasarnya, animasi adalah transformasi objek dimana semua Litik pada
sembarang objek akan diubah sesuai dengan aturan lertentu. sementara sistem Koordinatnya
tetap. Implementasi pada animasi dapat dikerjakan sccara interaktif maupun non interaktif,
Dibandingkan animasi non interaktif, animasi interaktif memberikan tampilan yang lebih
menarik dan dinamis. Pada animasi interaktif, pergerakan objek mengikuti perintah vang
diberikan oleh pemakai lewat perangkat interaktif, sedangkan animasi nom interaktif,
pergerakan objek hanya dikendalikan dari prosedur yang ada di dalam program-program
permainan, sedangkan animasi non inreraktif kebanyakan untuk melakukan simulasi objek.

Pembuatan aniamsi masih dilakukan secara sederhana dan konvensional dengan
cara menggerakkan beberapa pambar secara bergantian dan cepat sehelum tahun 1970-an.
Gambar tersebut masih menggunakan lukisan tangan atau menggunakan foto dan
scrangkaian kejadian, hingga pada akhir tahun 1970-an, seorang ahli program bernama
Julian Gomez mengembangkan sebuah program khusus untuk animasi. Pengembangan
program tersebut dilakukan di Negara bagian Ohio, Amerika Serikat.

Komputer digital yang berkembang pesat sangal mempengaruhi proses pengerjaan
animasi. Animasi kemudian membentuk suatu bidang baru dalm ilmu computer vaitu

grafika computer yang dapat digunakan untuk menggambarkan cara kerja suatu alat dan




menampilkan keluaran program berupa gambar vang lebih hidup dan interalktit. Animasi
banvak digunakan pada berbagai bidang scperti bidang perckayasaan, arsitektur, ckonomi,
kedokteran dan lain-lain.

Animasi vang bagus dihasilkan dari pambar yang cukup banvak agar gambar vang
dihasilkan akan tampak gerakan yang berkesan halus. Gambar-gambar tersebut haruslah
berpindah posisi sekecil mungkin agar pada perubahan atau pergantian gambar terlihat
lebih menarik dan bagus. Selain ilu dieperlukan juga keccpatan tertentu untuk tampilan
vambar vang akan dibuat dalam animasi. [lal ini tergantung pada jumlah pambar yang
diberikan. kecepatan vang dimaksud yaitu begitu suatu gambar ditampilkan, maka akan
berganti gambar berikutnya dengan kecepatan tertentu, makin cepat pergantian antara satu
gambar dengan gambar berikutnya maka akan menghasilkan gerakan gambar vang semakin

halus,

25  Format Citra
Dalam sistem operasi Windows, mendukung beberapa jenis format gambar.
Aplikasi pengolahan grafis juga menycdiakan [asilitas untuk membuka fife — file dengan
formal yang berbeda. Adapun heberapa jenis format gambar yang didukung oleh sistem
operasi Windows dan aplikasi grafis seperti : JPEG, WMF, BMP dan GIF.
2.5.1  Format Citra JPEG

IPEG ( Joimt Photographic Experts Group) adalah teknik kompresi grafik
high color bit  mapped dan juga standar file yang dikembuangkan oleh grup joint
photographic experfy vang menggunakan kombinasi DCT  (Discrere Cusine
Tramsform) dan pengkodean huffman untuk mengkompresi suatu fife citra.

IPEG adalah suatu algoritma kompresi yang bersifat fossy dimana kualitas
citranya kurang bagus. Lossv compression adalah mctode memperkecil ukuran fife
citra dengan cara membuang beberapa data, hal ini menyebabkan adanya sedikit
penurunan kualitas ecitra. JPEG merupakan teknik dan standar universal untuk
kompresi dan dckompresi citra tidak bergerak untuk digunakan pada kamera digital
dan sistem pencitraan menggunakan komputer yang dikembangkan oleh Join

photegraphic experts group.




2.5.2 Format Citra WMF

WMF { Windows Meta File) adalah suatu format jife¢ prafik standar
Windows yang biasanya digunakan pada cfipboard dan representasi sebuah grafik
Format file ini menyimpan semua komponen dari suatu grafik beserta dengan
atribut — atribulnya seperti paris (fimes), warna (cofeny), pola (patterns), teks (rexr)
dan atribut teks (text attributes). Adapun jenis l[ormal file WMF yang telah
ditingkatkan dari segi kualitas grafiknya vaitu EMV (Enchange Meta File).

2.5.3 Formaot Citra BMP

Format file BMP merupakan format fife gambar standar untuk komputer —
komputer yang menjalankan sistem operasi Windows. Format fife ini dikembangkan
olch pihak Microsoft untuk menyimpan file gambar (bitmap) dan memungkinkan
Windows untuk menampilkan kembali gambar terscbut. Struktur dari file BMP
terdin dar  Bitmapfileheader dan Bitmapinfoheader. Struklur Bitmapfileheader
menyimpan informasi mengenai dimensi dan format warna dari device independent
bitmap (DIV).

Jadi dapat’ disimpulkan bahwa Bitmapfileheader memberi informasi
mengenai file dan Bitmapinfoheader memberikan informasi mengenai gambar.
l'abel warna vang didefinisikan schagai array dan struktur RGBQUAD dan sisanya
adalah data gambar. Format ini mendukung resolusi dan monokrom hingga frue
ceor (16,7 juta warna).

2.5.4  Format Citra GIF

GIF (Graphics Interchange Format) merupakan formal gambar standar yang
menyediakan scjumlah kemampuan seperti ketajaman gambar (sharp) resolusi
gambar (resofution) yang baik serta ukuran file gpambar yang relatif lebih keeil.
Bagus tidaknya resolusi gambar GIF yang dihasilkan juga tergantung pada
perangkal keras (Graphics Hardware) yang digunakan. Perangkat keras lersebut
harus dapat menghasilkan resolusi wama gambar yang lajam dengan pixel warna
yang haik.

Pixel merupakan eclemen yang terkecil dalam sebuzh gambar. Pixel

berhubungan dengan titik (dof) dalam layar grafik. Misalnya sebuah gambar




memiliki ukuran sebesar 320 x 320, Hal ini mempunyai arti bahwa gambar tersebuit
mempunyal jumlah pixel scbanyak 320 x 320. Semakin banyak péxel yang terdapat
dalam objek gambar, maka semakin halus gambar tersebut karena jarak antar pixel
semakin rapal dan semakin besar ukuran fife terscbut. Begitu juga sebaliknya,
dimana semakin sedikil jumlah pixe/ vang terdapat pada ohjek gambar, maka
tampilan gambar tersebut terlihat kasar karena jarak antar pivel renggang dan
ukuran file yang dihasilkan lebih keeil.

Format GIF ditujukan untuk mendukung format gambar saat ini dan format
gambar yang akan datang. Formart GIF mempunyai ekstensi .gif yang didukung oleh
aplikasi gralis, misalnva Microsefi Paimt, Corel Draw, Corel Photolaint, Adobe
PageMaker dan sebagainya.

2.6  Visual Basic 6.0 3

Visual Basic (sering disingkat sebagai VB) adalah merupakan scbuah bahasa
pemrograman yang menawarkan ftegrated Development Environment (IDE) visual untuk
membuat program perangkat lunak berbasis sistem operasi  Microsoft Windows dengan

menggunakan model pemrograman Komputer.

Microsoft Visual Basic merupakan bahasa pemrograman yang berbasis microsoft
windows, sebagai bahasa pemrograman yang mutakhir, Microsoft Visual Basic 6.0 didesain
vnluk dapat memanfaatkan fasilitus yang lersedia dalam Microsoft windows. Microsoll
Visual Basic 6.0 juga merupakan bahasa pemrograman Object Oriented Programing (OOP),

yaitu pemrograman yang berorientasi objek.

Visual Basic merupakan salah satu sofiware untuk membuat program yang cukup
sederhana tetaupi banyak cakupan yang dapat dikerjakan, karena visual basic dapal
mengakses banyak sofiware seperti Excel, Access dan sebagaiva. Visual basic lebih
sederhana dari pemrograman yang lain. Kesederhanaan visual basic terletak pada
kemudahan membuat bahasa pemrograman dan bentuk tampilan yang dikehendaki. Visual
Basic ini merupakan pengembangan bahasa basic yang diterapkan pada program yang

berbasis Windows,




Visual Basic 6.0 adalah salah satu development tools untulke membangun aplikasi
dalam lingkungan windows. Dalam pengembangan aplikasi. visual basic menggunakan
pendekatan visual untuk merancang user inferface atau tampilan dalam bentuk form,
scdangkan untuk kodingnya menggunakan bahasa basic yang cenderung mudah dipelajari.
Visual basic telah menjadi wols yang terkenal bagi para pemula maupun developer. Dalam
lingkungan windows user interface memegang peranan penting, karena dalam pemakaian
aplikasi yang kita buat, pemakai senanliasa berinteraksi dengan user interface tanpa
menyadari bahwa di belakangnya berjalan instruksi-instruksi program yang mendukung
tampilan dan proses yang dilakukan. Pembuatan program pada visual basic seperti
pembuatan program pada bahasa-bahasa lain, hanya saja pada visual basic banyak
kemudahan yang dimiliki dibanding dengan program lain. Sccara garis besar pembuatan
program pada visual basic ada liga bagian yaitu pengaturan form, pengaturan properties dan
pembuatan program pada jendela code, Setelah selesai dibuat, program dapat dikompilasi
sehingga menghasilkan executable program atau langsung dijalankan pada lingkungan

visual basic.

Visual Basic merupakan bahasa pemrograman yang sangat mudah dipelajari. dengan
teknik pemrograman visual yang memungkinkan penggunanva untuk berkreasi lebih baik
dalam menghasilkan suatu program aplikasi. Ini terlihat dari dasar pembuatan dalam visual
basic adalah FORM, dimana pengguna dapat mengatur tampilan form kemudian dijalankan

dalam script yang sangat mucdah.

Ledakan pemakaian Visual Basic dilandai dengan kemampuan Visual Basic untuk
dapat berinteraksi dengan aplikasi lain di dalam sistem operasi Windows dengan komponen
ActiveX Control. Dengan komponen ini memungkinkan penguna unluk memanggil dan
menggunakan semua model data vang ada di dalam sistem operasi windows. llal ini juga
ditunjang dengan teknik pemrograman di dalam Visual Basic yang mengadopsi dua macam

jenis pemrograman vyaitu Pemrograman Visual dan Object Orienled Programming (OOP).

Visual Basic 6.0 sebetulnya perkembangan dari versi schelumnya dengan beberapa
penambahan komponen yang sedang tren saal ini, seperti kemampuan pemrograman

intemet  dengan DHTML  (Dynamic HyperText Mark Language), dan  heberapa
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penambahan [fitur database dan multimedia yang semakin batk. Sampai saat buku ini ditulis
bisa dikatakan bahwa Visual Basic 6.0 masih merupakan pilih pertama di dalam mombuat
program aplikasi yang ada di pasar perangkat lunak nasional. Hal ini disebabkan oleh
kemudahan dalam melakukan proses development dari aplikasi yang dibuat.

Pembuatan program aplikasi menggunakan Visual Basic dilakukan dengan membual
tampilan aplikasi pada form. kemudian diberi script program di dalam komponen-
komponen yang diperlukan. Form disusun oleh komponen-komponen yang berada di
[Toolbux], dan scliap komponen yang dipakal harus diatur propertinya lewat jendela
|Property|.

CGambar 2.1 Tampilan Bahasa Pemrograman Yisual Basic 6.0
Menu pada dasarnya adalah operasional standar di dalam sistem operasi windows,
seperti membual form baru, membuat project baru, membuka project dan menyimpan
project. Di samping itu terdapat fasilitas-fasilitas pemakaian visual basic pada menu. Untuk

lebih jelasnya Visual Basic menyediakan bantuan vang sangat lengkap.




Menu pada dasarnya adalah operasional standar di dalam sistem operasi windows,
seperti membuat torm bary, membuat project barn, membuka project dan menyimpan
praject. Di samping ity terdapat fasilitas-Tasilitas pemakaian visual basic pada menu. Untuk
lebih jelasnya Visual Basic menyediakan bantuan yang sangat lengkap.

Toolbox berisi komponen-komponen yang bisa digunakan oleh suatu project aktif,
artinya isi komponen dalam toolbox sangat tergantung pada jenis project vang dibangun,
Komponen standar dalam toolbox dapat djlihat dalam panel kanan program Visual Basic.

Dengan menggunakan Yisual Basic maka setiap objek baik dalam bentuk gambar,
movie, ataupun suara dapat terorganisir dengan baik, dengan demikian Visual Basic dapal

digunakan untuk membuart game.

2 Microsoft Access 2007

Microsoll Access (Microsoft Office Access) adalah schuah program aplikasi basis
data kemputer relasional yang ditujukan uniuk kalangan rumahan dan perusahaan kecil
hingga menengah. Aplikasi ini merupakan anggota dari beberapa aplikasi Microsott Otfice,
selain tentunya Microsoft Word, Microsofl Excel, danMicrosoft PowerPoint. Aplikasi ini
menggunakan mesin basis data Microsoft Jet Database Fngine, dan juga menggunakan
tampilan grafis vang intuitif sehingga memudahkan pengguna.

Microsott Access dapal menggunakan data yang disimpan di dalam [ormal Microsott
Access, Microsoll Jet Database bingine, Microsoft SQL Server, Oracle Database, atau
semua kontainer basis data yang mendukung standar ODBC, Para pengguna/programmer
yang mahir dapai menggunakannya uniuk mengembangkan perangkal lunak aplikasi yang
komplcks, sementara para programmer yang kurang mahir dapat menggunakannya untuk
mengembangkan perangkat lunak aplikasi yang sederhana. Access juga mendukung teknik-
teknik pemrograman herorientasi objek, tetapi tidak dapat digolongkan ke dalam perangkat

bantu pemrograman berorientasi objck.

2.8 Adobe Photoshop i
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sepuluh disebul Adobe Photoshop CS3, versi kesebelas adalah Adobe Photoshop C54 dan
versi vang terakhir (keduabelas) adalah Adobe Photoshop CS35. Photoshop tersedia untuk
Mierasaoft Windows, Mae OS X, dan Mae OS; versi 9 ke atas juga dapat digunakan oleh

sistcm operasi lam

29 Permainan Space Wing

Misi dalam permainan ini adalah menembak sebanyak mungkin alien yang bergerak
menuju ke bumi, sambil menghindari alien yang berusaha mencoba menabrak pesawal
Space Wing milik pemain secara gagah berani (atau bodoh). Perlu di ingat bahwa satu
icmbakan tidak bisa meledakkan alien, pemain dapat menggerakkan Space Wing dengan
tombol panah dan menembak dengan menekan tombol Space bar, Permainan berakhir jika
power kesehatan pesawat Wing habis. Permainan dalam setiap game ini sampai dengan
level 5 dimana setiap levelnya permainan ini memilki tingkat kesulitan yang semakin sulit

ketika permainan semakin ke level tertinggl.




BARB I
PEMBAHASAN DAN PERANCANGAN

Pembahasan
Proses perancangan permainan fame perang pesawal Space Wing melalui beberapa
Lahapan proses schagai berikut:
I. Perancangan Gambar Pesawat
Pesawat yang digunakan dalam game ini terdin dari ;
a. Red Wing ! pesawat merah
b. Blue Wing / pesawal biru
Kedua pesawat tersebut memiliki perbedaan dari segi tembakan peluru, dimana Red
Wing memiliki tembakan peluru standar sedangkan Blhie Wing memiliki lembakan
peluru yang yang lebih kuat. Akan tetapi untuk menggunakan Blue Wing pemain
harus menyelesaikan terlebih dahulu permainan dilevel 1 schingga dilevel berikutnya
pesawal Blue Wing sudah bisa digunakan, namun Red Wing juga masih bisa

digunakan tergantung pemain ingin memakai pesawat sesuai kesukannnya.

-2

Perancangan (ambar Musuh
Musuh dalam game Space Wing ini ada 2 type yaitu 4fien dan Boss.
Alien sendin terdini dari 5 karakter yaitu :
i, Aliern Eve
b, Alien Deman
e Alierr Devil
d  Alien Phoenix
¢. Alien Dragon
Sedangkan Boss sendiri terdiri dari 5 karakicr juga vaitu :
& Boss Draven Fire
b, Boss Saiya
Boss Deagonfly

T

R

Bosy dAxsisin

¢ Bowy Monk

[ 6




3.2

3,

Perancangan Animasi dan Suvara.

Gambar pesawat atau alien dan juga boss pada saat meledak, simbol musuh
telah hancur dan tembakan berhasil dicari pada sumber-sumber di iniernel,
kemudian di-editr dan  disimpan dengan menggunakan  aplikasi  Adobe
Photoshop. Efek animasi vang digunakan merupakan proses pergantian gambar,

Sedangkan suara ledakan dirancang dengan menggunakan aplikasi Recorder.

Membuat Mask dengan Adobe Photoshop

Ada Banyak program desain grafis yang dapat digunakan untuk membuat sprite dan

mask yang akan sava gunakan dalam pembuatan program permainan. Salah satunya

adlaah Adobe Photoshop. yang dapat digunakan untuk membuat sprite sekaligus

mask dengan mudah.

1.
2

L]

Bukalah file baru melalul menu File = New. Tentukan ukucan gambarnya.
Buatlah warna latar belakang menjadi hitam dengan Edit > Fill dengan
Content > Use : Black.

Kita dapat menggambar sprite diatas latar belakang hitam dengan pencil tool,
Brush tool, dan sebagainya.

I Adobe Photoshep  [BOSS044.GIF @ 1005 (Indexi] ]
) e ER lmage Laver Seledt Flter Yiew Window Help - @ X

73 = by ) | Pediers Bps Shghit | Mur i w

1Mre | Dioc: 27 80T 85 B Tirimes sedactiors fnam conder o bt from acicing selsctior

Gambar 3.1 Menggambar Sprite




15

4. Jika sudah sclesai, tekan D untuk mengubah wama yang akan digunakan
menjadi hitam-putih. Seleksi gambar dengan menekan Cerl + A, atau menu
Seleet = AN Kemudian, copy gambar ke clipboard dengan menckan CTRL +
C. atau menu Edit > Copy.

5. Selanjutnya kita perlu melebarkan kanvas melalui menu Image > Canvas Size.
Kita dapat menempatkan mask di sisl manapun. Misalnya, kita akan
menempatkan mask di sisi bawah, maka tinggi gambar harus diperbesar dua kali
ke bawah, Dalam contoh gambar dibawah ini tingginya adalah 110 pixel, maka
kanvas akan diperbesar menjadi 220 pixel ke bawah. Perhatikan anchor-nya,
karena panah adalam kotak anchor tersebut akan mengatur arah perbesaran,

6. Pastc pambar di clipboard ke sisi bawah. sehingga kita akan memperoleh dua

layer.

I adubcMetoalap - [Untitl=a-) 5 '-I.'II'I'. ||. Ay .".H':;H."".:I]
D Hs B fenge Loy Geiect P flew Wiodos e

by = hunSdetlow [ ShowBondngBe © 10-ds 03 |5 % == ik

B Ml
9 | [Papad 3
[ ues | oo wr stk B Choh ek drag s o Leyr cor e 4 Dopy of wekoclion. <) 'l.ﬂ d rili bl i

Gambar 3.2 Paste Gambar Clipboard
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7. Pilih Magic Wand Tool, dar atur nilai Tolerance-nya. Nilai tolerance ini akan

&

menentukan seberapa “peky” magic wand membedakan intensitas wama, Klik

bagian hitam {5181 luar) darl gambar.

r B hdooo Phorovbiog  [Usiilled @ 10000 w8 EEE |
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.
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Gambar 3.3 Teknik Magic Wand Tool

Tekan X untuk menukar warna foreground dan background yang akan
digunakan. Kemudian tekan Alt + BackSpace atau menu Edit > Fill, content
use : Foresround Caolor,

Pilihan kemudian dibalik dengan menekan Ctrl + Shift + I, atau menu Select >
Inverse. Mungkin kita perlu menghilangkan pilihan di sisi atas yang terjadi,
Untuk itu tahan Alt, kemudian klik bagian yang ingin dihilangkan dengan
magic wand. Setelah garis pilihan hanya mengelilingi sprite, tekan D untuk
menjadikan wama hitam sebagai foreground color dan tekan Alt + Backspace,

atau menu Edit > Fill. Anda akan memperoleh Mask dibawah gambar sprite.




3.3

t, hdoho I‘hr,a:n'.:lmp [[‘II,ZI"uHI'I'1 Cell o et P | I1|||r-'|:lj F: |m|m

T He Bt e (e et Pl Vew Widow fidp - a%
(3= g4 B Pedhen (@p e Homad g
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Gambar 3.4 Setelah di Masking
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10. Simpanlah gambar terscbut dengan memilih menu File > Save Optimized As.

Format GIF sangal baik untuk gambar - gambar karlun yang variasi warnanya

ridak kompleks, sedangkan Format JPG baik untuk menyimpan gambar dengan

variasi warna seperti foto. Visual Basic versi 6 memilki kemampuan dalam

membaca file gambar yang dikompres dalam format GIF maupun JPG,

Microsoft Access 20007

Microsofl Access dapat menggunakan data yang disimpan di dalam format

Microsoft Access, Microsoft Jet Database Engine, Microsoft SQH. Server, Oracle

Database, atau semua kontainer basis data vang mendukung standar QDBC. I'ara

pengglna/programmer yang mahir dapal menggunakannya untuk mengembangkan

perangkat lunak aplikasi yang kompleks. sementara para programmer yang kurang

mahir dapat menggunakannya untuk mengembangkan perangkat lunak aplikasi

vang sederhana. Access juga mendukung teknik-teknik pemrograman berorientasi

objck. tetapi tidak dapat digolongkan ke dalam perangkat bantu pemrograman

berorientasi objek.
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alam game ini, tidak terdapat tampilan halaman home database akan tetapi
terdapal dua (2) database yvailu database pernain dan database skor tertinggi.

| 1 bay 5 45600
i 2 boy 3 7500
'] 3 SANDY 5 17300
3 4 SANDY 5 17100
[ 5 SANDY 5 15500
- 6 ANJAR 4 12900
B 7 ANJAR 5 15300
] § SANDY 4 12200
il ! 3 SANDY a 15300
I 10 SANDY 4 15500
1 11 SANDY 4 14400
1] 12 SANDY 5 16300
| 13 TERA 4 16700
iR 14 TERA 4 16500
1 15 TERA 5 16900
| 15 TERA a 13500
i 17.SANDY 1 2400
*|

Gambar 3.5 Tampilan Database Skor Terlinggi

Gambar 3.6 Tampilan Database Pemain
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Nama ; Arisandy Sya’ban
Nim 1 05.12.528
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Untuk Mahasiswa :
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INSTITUT TEKNOLOGI NASIONAL
JL. Raya Karapglo,Km 2 MALANG

Lampiran . 1 {satu) berkas
Pembimbing Skripsi
Kepada + Yth. Ibu Sandy Natali Mantja,S.KOM

Drosen [nstitut Teknologi Nasional

Malang

Yang bertanda tangan di bawh ini:

MNama : Arisandy Sya’ban

NIM 1 05.12.528

Jurusan : Teknik Elektro 5-1

Konsentrasi  : Teknik Komputer den Informatixca

Dengan ini mengajukan permohonan, kiranya Ibu bersedia menjadi
Dosen Pembimbing Pendamping untuk penyusunan 3kripsi dengan judul

{proposal terlampir):

* Pengembangan Game Perang Pesawat Space Wing Menggunakan
Visual Basic 6.0

Adapun tugas tersebut sebagai salah satu syaral untub menempuh Ujian
Akhir Sarjana Teknik.

Demikian permohonan kami buat dan atas kesediazan Ibu kami veapkan

terima kasih,
Mengetabui Malang , Jumi 2011
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Pembimbing Skripsi

koepaidit S Yl Bapak M. Ibrahim Ashari, S TN
Dosen [nstitut Teknoelogi Nasional

Malang

Yang bertanda tangan di bawah ini.

Nama . Arisandy Sva'ban
NI - 05.12.528
Jurusan : Teknik Elektro 5-1

Konsentrasi  : Teknik Komputer dan Informatike

Dengan inl mengajukan permohonan, kiranya Bapak bersedia menjad
Dosea Pembimbing Utama untuk penyusunan Skuipsi derngan judul

{proposal terlampic):

“ Pengembangan Game Perang Pesawat Space Wing Menggunakan
Visual Basic 6.0 *

Adapun tugas tersebul scbagai salah satu syarat untuk menempuh Ujian
Akhir Sarjana Teknik.

Demikian permohonan kami buat dan 31as kescdiasan Bapak kami

ucapkan terima kasih.
Mengetahui Malang , Jnzi 2011
Ketua Jurusan Tekoik Elektro 5-1 Hormat kami
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LAMPIRAN

Sub Nirst_datal)
xwing = {areawidth + wingwidth) / 2
ywing = arcaheight - wingheight
xwingnff =7
ywinpoff =7
wingliP = 200
Score=10

Level= 1

Call Initialize_Level{Level)
Wkt=10
Score Lbl.Captign ="
PBarLife. Value=0
Call rawText(area_pic, "Loading ...~ 104, 184, False, False, False, 40, 20, 0, 18, "Yerdana™)
Timerl.Enabled = True
End Sub
Private Sub Starl_{ame()
Call Backsroundmusic
main_rontine
End Sulr
Sub check key()
If (GetKevState{vbReyLeft) And Key down) Then xwing = xwing - xwingoff
If (GetkeyState{vbKeyRight) And Kﬂr‘_lluwt_l} Then xwing = xwing + xwinpoft
I (GetKeyState{vhKey1ip) And Key_down) Then ywing = ywing - ywingofT
If (GetKevState{vbEKeyDown} And Key_duwl;} Then ywing = ywing + ywinpofl
check border

[Tweapontrig_time <2 Then weapontrig_time = weapontrig_time — 1




If (GetKeyState(vbKeySpace) And Key _down) Then make weapon
If (retKeySiate(vhey(?) And Key_down) Then sameover = True
End Sub
Private Sub Initialize Level{Level As Integer)
Dim i As Integer
awing = (areawidth + wingpwidth) / 2

vwing — arcaheighl - wingheighi

boss.active = False
Fori=0To {maxexplode - 1}
explode{il.active = False
MNext
Fori=0 To (maxBomb - 1)
Bombifl.active = False
Mext
boss.HFF =10
Labell, ¥Yiaihle = False
PRarBoss. Visible = False
explodeBoszactive = False
exp_pic.Picture = Load Ficture{ App. Fath & "explodegii™)
Select Case Level
Case 1
maxenemy = [k maxBomb =2: BombWidth = 77: Bomhbheight = 68
Helim enemy(maxenemy - 1)
Enemy_pic.Picture = LoadPicture{App.Path & Menemyl 1.gil™)
Back Pic.Picture = LoadPiciure(App.Fath & "™backi,zil™)
Wing pic.Picture = Load Picture{ App, Path & "\wing.gif"}
Weapnn_pic.Picture = Load Picture{ App.Path & "weapond5.gif'")
Boyy Pic Picture = LoadPichuref App. Path &£ ™ Bassil].gif™)

Bomb Piv.Picture = LoandPiciure{ AppPath & MBOMBO1gil™)




"HP Boss = 20
HP_Enemy = 1
I Bomb = 100
PBarBoss. Max = 200
PBarBoss.Value =10

Case 2
maxencmy = 2: maxBomb = 2: BombWidth = 44: Bombheight = 6%
Hellim enemy{maxenemy - 1)
Enemy_pic.Picture = LoadPictore{App.Path & "enemyD2.gil™)
Back Pic.Ficture = LoadPicture{ App.Fath & "\hack02Z.gif™)
Wing_pic.Picture = Load Picture(App,Path & "\wingl2.gif™)
Weapon_pic.Ficture = Load Picture(App.Path & "weapon3.gil''y
Boss_Pie.Picture = LoadPicture{App.Path & "\Boss02.gif™)
Bomb_Pic.Fieture = LoadPicture(App.Fath & " BOMBO2.gif"')
"HI* Boss = 404
HF_Enemy = 100
HF Bomb =10
PBuarBoss.Max = 400
PBRarBoss. Y alue =1{)

Cased
maxenemy = 3 maxBomb = 3: BombWidth = 50: Bombheight = 68
Reldim enemy{maxenemy - 1}
Enemy pic.Picture = LoadPicture{App.Path & "enemy3.gif"")
Back_ Pic.Picture = Load Picture{App. Fath & ""\back03.2il")
Wing_pic.Picture = LoadPicture{App.Path & ""wing.pif™")
Weapon pic.Picture = LoadPicture(App.Path & "weapon03.gif')
Boss PicPicture = LoadPicturel App. Bath & "\Bos3.0i™)
Bomb_Pic.Ficture = I.nadl’iciure[.-tppri'ntll & "BOMBOI.gn")
"HPF_Boss = 600

HFP Enemy = 160




P Bomb= 104
PBarBoss.Max = 600
I"Barloss. Value =10

Case d
maxenemy = 40: maxBomb =3: BombWidth = 65: Bombheight = 63
ReDim enemy(maxedemy - 1)
Enemy pic.Picture = Lond Picture(App.Path & "MenemyiM4.gil")
Back_Pic.Picture = LoadPictureCApp.Fath & Mback(4.git™)
Wing pic.Picture = I.nndl’icrure[App.rath & Mowingd2.gil™")
Weapon_pic.Picture = I.undl"’iL"ture[rth.Fath & "oweapon0d.gil™)
Boss_Pic.Picture = LoadPicture{App.Path & " Bosalkdgil)
Bomb_FPic.Picture = Load Picture{ App, Path & "\BOM B04.211)
THE Boss = R0
HP_Enemy = 200
HF Bomb = 101
PBarBoss.Max = §00
PBurBoss.Value=10

Case 5
miavenemy = 50: maxBomb = 3: BombWidth = 144: Bombheight = 68
Rel¥im enemy{maxenemy - 1)
Enemy_pic.Picture = LoadPicture{App.Path & "enemy05.gif"")
Back Pic.Picture - LuadPicture{ App.Path & "back05.gil™)
Wing_pic.Picture = LoadPicture{App.Path & "Mwing.zil”)
Weapon_pic.Picture = LoadPicture(App Path & "weapon05.gif™)
Boss_Pic.Picture = LoadPicture{App.Path & "\Bossli5.pil™)
Bomb Pic.Piviure = LoadPicture{ App.Path & "\BONMBUS.zil")
HP_Boss = 1000
HF Enemy =200
HP_Bomb = 2MHl

PBarBoss.Max — 1




PRBarBoss Valoe =1
End Select
LLevel. Caption = Level
End Sub
Sub cheek_enemy_wing(i As Integer)
If (ememy(i). X + enemywidih) = xwing And enemy(i).X < [xwing + winpwidth) Then
If {enemy(i). ¥ + enemyheight) = ywing And enemy{i}.¥ < (ywing + wingheight} Then
enemyii)active = False
Call make explode(i)
wingHFP = wineHP - 10
If wingHP <= 0 Then
Call display_statns
"MsgBox "Game Over! Yoor wing has lost its pawer', vbCritical, "Game Over™

Call Diraw Text{area pic, "Anda Kalah! Wing Kehabisan Power®, 104, 1584, False, False, False,
4, 20, 0, 18, "Verdana")

With Scorel
JBScore = Get [D5core
MNoma = Pempin.Nama
.LevelGame = Format(Level - 1, "0}
HiSrore = Score
Call Save Scord IDScore, Nama, LeyelGame, iScore)

End With

delay (5000}

pamenver = True

End IF
End I

End If

End Sub
Sub check_Boss Wing()

IF (boss. X -+ bosswidth) > swing And boss.X = (xwing + wingwidth) 'Fhen




If {boss. Y + Bumbheight) > ywing And h[l?!ﬁp\‘lr = (ywing + wingheight) Then
"Call make explodefi)
wingHP = winglIl*- 10
If wingHP == 00 Then
Call display status

Call DrawTextares_pic. "Anda Kalah! Wing Kehahisan Power", 104, 184, False, False, Falye,
4k, 20, 0, IR, "Verdana")

With Scorel
JDRGcore = Get [IDScore
Mamka = Pempin.Mamu
JLevellrame = Format(Level - 1, 700™)
HiScore = Score
Call Save Score . 1DScore, Nama, .LevelGame, .HiScore)

End With

delay (S000)

"MegBox "Came Over! Your wing has lost s power”, vbCritical, "Game Over''

pamenver = Trug

Fonad IT
e 1
End IF
Sub check weapon_enenmiy{i As Infteger)

Dim j As Integer

For j =1} To (maxenemy - 1)
If (enemy{j)active} And (weapon{ij.active) Then
1f (weapon(i}. X + weaponWidth) = enemy{j). X And weapon{i}).X < {(enemy(j).X + cnemywidih} Then

If (weapon(i).¥ | weaponheight) > enemy(§).Y And weapon{i).¥ < {enemy(j).Y +enemyheight)
Then

enemy(jl.H* = enemy(j). HP - 20
If enemy(j).HF = 1 Then

enemy(jl.aclive = False




Score = Score + BM
Call make_explode(j)

End If

wiaponii)active = False

Exit For

End 17
End If
End IT

Next j

End Sub
Sub check weapon_Boss(i As Integer)
Dim j Az Inleger
I {boss.activel And (weapon{i).active) Then
If (weapon(i}).X + weaponWidth) > boss. X Aod weapon(i). X < (boss. X + bosswidth) Then
If {weapon(i).Y + weaponheight) > boss. Y And weapon(i).Y < (hoss.¥ + bossheight) U'hen
bioss. HP = boss. HP - 20
Il boss. HP = 1 Then
bossactive = False
seore = Score + 1000
Call make explodeBoss
Furi=0To (maxBomb - 1)
Bonbiil active = False
Mext
End If
wedpoen(ijactive = False
End If
End Ef
Knd IT

Foml Sub




Sub make explode{j As Integer)

Dim i As Integer

Fori=0To (maxexplode - 1}
If explode(i).active = False Then

Wirh explode(i)

.active = True

dime=10

X =enemy(j)LX

Y = enemy(j)Y

Call sound

End Yiih

Exit o

End If

Mext i

End Sub

Sub make explodeBombij As Integer)

Ihim i As Integer

Fori=0To (maxexplode - 1)
If explode(i)active = False Then

With explode(i)

Active = True

Aime =10

X = BombijLX

¥ = Bomb(j). ¥

Call sound

End With

Exit For




End If

Mext i

End Sub
Sub make_explodeBoss()
With explodeBoss
Aactive = True
dime =0
X =hoss. X + ((bosswidth - BombWidth) [ 2)
"X = hoss. X
¥ = boss Y
Call sound
End With
End Sub
Private Sub Save Score(IDScore As String, Nama Az String, Level As String, HiScore Az Integer)
Dim Sqlemd As String

Sqlemd = "Insert inte Score Values("' & IDSeore & "' & MNama & " & Level & ," & Hi%Score
& “') U

My Db, BepinTrans

My Db Execufe (Sqiemd)

Ml [ Coommimit’l rans
End Sub
Frivate Sub Update_Pemain(Nama As String, LevelGame As Siring, Score As Integer)
DMim Sqlemd As String

Sqlemd = "Update Pemain Set LevelGame =" & LevelGame & ", Score = " & Score & "' Where
Mama="" & Nama & """

iy Db BepinTrans

My Db Excoute (Sglemad)

My Dh.Commit'l rans
End Sub

Sub main_routine)




Dim Status Final Az Boolean
Time Level=10
Stutus Final = False
pameover = False
Do

delay (15)
aldxwing = xwing
Call check key
Call area_pic.Cls
Call dispiay_back
Chall display wing
Call move_weapon

'Time_Level =Time Level +1

If Time. Level = 500 T hen
Time Level = Time_Level + |
Call make enemy
Call move enemy
Call display_explode
Flseif Time_Level = 500 Then
If Yot check StatesAll Knemy Then
Call move _enemy
Call display_sxplode
Time_lLevel = Time_Level + 1
Call make boss
weaponirigl time =1
Else
Call move_enemy
Call display_explode

End If




Elself Time_1evel = 500 Then
If boss. 1P = 0 Then
Call move _hoss
ITweapontrigl _lime <2 Then weapontrigl_time = weapontrigl_fime + 1
Call make Bomb
Call move_Bomb
display_explode
Juml_Ledakan =3
Else
Call display_explode Boss
I Mot explodeBoss.active Then
Level = Level +1

If Lewel == maxlevel Then

Call DrawTest(area pic, "LEVEL " & Level- 1 & " SELESAI", 104, 184, False, False,
Falsc, 40, 20, B, 18, "Verdana")

Yith Femain
Jinma — NamaPemain
LevelZame = Farmat{Level, "(H™)
Score = Score
Call Update Pemain{.Nama, .LevelCame, Score)
End With
delay (2000)
Time Level =0
Call Initialize Level{Lewvel)

Elsc

Call Draw Text(arca_pic, "Selam ! Ands Menang...", 14, 184, False, False, False, 40,
21, 0, 18, "Verdana™)

With Scorel
J¥Score = Get_IDScore
Mama = Pemain.MNama

JLevelGame = Format{Level - 1, "00")




HiScore =Score
Call Save Scorcl IDScore, .MNama, .LevelGame, .HiScore)
End With
defay (2001
Statwes_Final = Truc
Exit Do
End IT
End IT
End If
End If
"ivove b
arca_pic.Refresh
Call display_stutus
Service Backe round Musiv "BGM ™
Loop Untl gameover = T'roe
Call CloseBGM
If Status_Final Then
Linload Me
FFinal.Show
Else
Linload Me
FMenulitamaShow
End If

End Sub




Gambar 4.7 Tampilan fevel 1 Selesai
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Gambar 4.9 Tampilan Boss permainan level 2
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Gambar 4.11 Tampilan permainan level 3
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Gambar 4.13 Tampilan level 3 Selesai




Ciambar 4.15 Tampilan Boss permainan level 4
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Gambar 4,17 Tampilan permainan level 5
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Gambar 4.18 Tampilan Doss permainan level 5
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Gambar 4.19 Tampilan Game Tamat
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Gambar 4.20 Tampilan Game Uver
Ketika permainan berakhir atau selesai, pemain dapal melihat skor vang diperolch
dengan masuk ke Menu Utama kemudian klik Skor Tertinggi untuk melihat perolehan Skor

Tertinggi dari semua pemain yang telah memainkan permainan Space Wing.

Gambar 4.21 Tampilan Form Skor Tertinggi
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Tombo! selanjutnyva dalam Menu Litama vaitu Petunjuk Game. Dimana Form
Petunjuk Game ini berguna untuk memberikan informasi lentang pelunjuk permainan dari

grame Space Wing bagi para pemain pemula.

w, IFetunjul Permainan El

rusane inencob

gluat Kita

y 1ol ()1 mainan dalam seciap £game
ini sampal dengan level 5 dinana setiap levelnya

permainan ini memiiki tinfkat kesulitan yang semakin

sulit Ketika rimainan semakin ke |eve| tertinggi.

Gambar 4 22 Tampilan Form Petunjuk Game




E14

Tombol selanjutnya dalam Menu Utama yaitu Profil. Form Profil berisikan entang

Data Diri sang Pembuat game Space Wing.

= ol

Cambar 4.23 Tampilan Form Protil




Tabel 4.1

Perbandingan Space Wing Lama Dengan Pengembangan Space Wing

Space Wing Lama

Pengembangan Space Wing

Permainan hanya mempunyai
misi mencari skor lerlingg tanpa

adanya Boss disctiap levelnya ‘

Enemy Alien hanya memilki 1

karakter dalam permainan

Yenjata dalam permainan lama
hanya memilki | jenis peluru
lembakan ‘

Pesawat Wing hanya terdapat |

pilihan

Tampilan animasi masih belum

full colowr (hitam putih)

Permainan mencapai level 5
dengan tambahan Boss pada

setiap levelnya

Setigp level permainan memiliki
karakter [nemy Alien vang
herbeda — beda

Senjuta Pesawat memiliki 2 jenis

peluru

Pesawal Wing memiliki 2 type
pesawal dengan warna yang

berbeda
Tingkat permainan setiap
levelnva semakin sulit apabila

level semakin meningkat

Tampilan animasi 21}
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BAB YV
PENUTUP

Kesimpulan

Setelah menyelesaikan pengembangan perangkat lunak permainan Space Wing

menggunakan bahasa pemrograman  Visual Basic 6.0, penulis menarik  beberapa

kesimpulan sebagai berikut :

I
2.

a2

o

Game telah bererientasi ke animasi 2D dari versi sebelumnya.

Dalam permainan ini telah ditambahkan lima (5) karakicr Enemy Alien dan

lima (5) karakter Boss.

Game 1ni memiliki lima () Tingkatan level dimana setiap levelnya skan semiakin
sulit permainannya apabila level semakin meningkat.

Pesawat Wing mempunyai dua (2) type vaitu Red Wing dan Blue Wing dimana
seliap pesawalnya memiliki jenis senjata yang berbeda.

Saran

Adapun saran dari penulis guna untuk pengembangan game selanjutnya :

Perangkat lunak dapat dikembangkan menjadi mudtiplayer agar dapat dimainkan
oleh lebih dari 1 orang.

Pada pengembangan game selanjutnya diharapkan tampilan animasi yang sudah

berbasis 3D,
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22

Aturan Permainan

Sistem permainan game perang pesawal Spece Wing ini adalah dengan
background Juar angkasa, dimana pemain hanya memiliki satu pesawat yang harus
dijaga keschatan pesawat tersebut untuk melawan alien - alicn yang banyak
jumlahnya, selain itu pesawat juga harus menghadapi Boss musuh vang sangat kuat.
Pemain diharuskan menembak sebanyak mungkin alien - alien untuk menyelesaikan
misi guna mendapal skor tertinggi dan juga untuk dapat melanjutkan game ke level

sclanjutnya sampai dengan game selesai.

Misi dalam permainan ini adalah mencmbak schanyak mungkin alien vang
bergerak menuju ke bumi, sambil menghindari alien yang berusaha mencoba
menabrak pesawat Space Wing milik pemain secara pagah berani (atau bodoh).
Perlu di ingat bahwa satu tembakan tidak bisa meledakkan alicn, pemain dapat
menggerakkan Space Wing dengan tombol panah dan menembak dengan menekan
tombol Space Bar. Permainan berakhir jika power kesehatan pesawal Wing habis.
Permainan dalam setiap game ini sampai dengan level 5 dimana setiap levelnya
permainan ini memilki tingkat kesulitan yang scmakin sulit ketika permainan

semakin ke level tertinggi.




3.5

Desain Sistem
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Secara waris besar desain sistem game perang pesawat Space Wing memiliki

gambaran seperti dibawah ini:

| EEMAM

MERL
UTARLA
¥ Y - ¥ - h
| SHOR PETLIM LM i
‘ o ‘ ‘ TERTINGG AME FRO¥ IL

Gambar 3.7 Desain Sistermn Game Perang Pesawat Space Wing
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3.8 Flowchart Game Perang Pesawal Space Wing

i

24

T TRMPILAN '\_
BELAMAT
SANDA BENANG -

=TRUE

GAME DWER
= TRUE

.1.\
¥,

| STATUS FiNAL |

L




3.6.1 Flowchart Lanjutan Game Space Wing
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(tambar 3.9 Flowchart Lanjutan Game Perang Pesawal Spoce Wing




3.7  Perancangun Game

Perangkat lunak permainan Space Wing ini dirancang dengan menggunakan bahasa

pemrograman Microsoft Visual Basic 6.0 denpgan didukung oleh beberapa aplikasi lainnva

seperti Adobe Photoshop dalam perancangan gambar dan Recorder dalam perancangan

suara. Komponen- komponen vang digunakan dalam pembuatan perangkat Tunak ini

sebagai berikut :

I.

fd

10,

12

13
14.

Form . merupakan lembaran kerja tempat meletakkan item dalam Firdow
Fisual RBosic.

Label : unit ini digunakan untuk menampilkan teks, angka, atau simbol pada
saal program dijalankan.

fext Box @ unit 1ni digunakan untuk menampilkan (eks pada form atau untuk
menerimsa fzpuf dari pemakai pada saat program Viswa! Bavic dijalankan,
Command Button © unil ini digunakan untuk memberikan suatu perintah atau
tindakan ketika digunakan.

Check Box : unit ini digunakan untuk memilih satu atau beberapa syarat sccara
bersamaan.

Comba Box @ unit dicunakan untuk memilih ilem lewat Drop-Leowsn List.

Line : unit it memungkinkan pemakal membual gans lurus,

Piciure Rox : unit ini untuk menampilkan file gambar ( Ritmaps, Icon, Gif, JPG
dan sebaganya).

fmage fBox © uml akan menampilkan gambar Bitmaps, Windows, Metafile dan
feae.

Timer < unit ini digunakan untuk mengoperasikan waktu kejadian pada rutin

program termasuk internal waknu.

. Shape @ Unit ini membentuk ohjek dua dimensi (bujur sangkar, lingkaran, empat

persegl panjang dan elips).

Pragress Bar . unil ini unluk menampilkan berapa lama  sualo operasi
berlangsung.

Menu fiditor @ unit ini digunakan untuk membuat menu aplikasi.

MSFlexCrrid ; unil ini digunakan untuk menampilkan informasi defabase,




Perangkat lunak permainan Space Wing int memiliki beberapa frm yaitu ;
. Fowrm Menw
2. Form Pemain.

Forrr Mulai,

L P ]

form Petunjuk.
Form Skor Tertinggi.
Form Profil.

> s

3.7.1 Form Menu

Cambar 3.10 Perancangan lForm Menu
Kelcrangan :

i Too! label

2 Tool TextBox
3 Toul label

4 Tool lahel

5. Tool label

6 Tool label

7

Tool label




3.7.2 Form Pemain

1

[ ey
/ - 5)

Gambar 3.11 Perancangan Form Pemain

Keterangan :

. Too!l DataList

2 Tool PictureBox

3 Tool CommandButton
4, Tool CommandButton
5 Tool CommandButton
6

Tool CommandButton




3.74 Form Petunjuk
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Lkl

Conremrd |

Gambar 3.13 Perancangan Form Petunjuk

Keterangan :
L: Tool Label

2. Tool CommandButton




3.7.5 Form Skor Tertinggi

&
i

Gambar 3.14 Perancangan Form Skor Vertinggl

keterangan :

1. Tool Label
Tool 1.abel
Tool TextBox

Ll bk

Tool CommandButton

=

It Tool CommandButton
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BAB IV
IMPLEMENTASI DAN PENGUJIAN PROGRAM

4.1 Implementasi

Tahap implementasi pengembangan perangkat lunak merupakan proses pengubahan
spesifikasi sistem menjadi sistem yang dapat dijalankan, tshapan ini merupakan lanjutan dari
proses perancangan, yailu proses pemrograman perangkat lunak sesuai dengan spesifikasi
kebutuhan perangkat keras (Aurdware) dan spesifikasi perungkat lunak (soffware) dan jugs
desain sistem.

Dalam aplikasi pembuatan Game Perang Pesawat Space Wing, program yang digunakan
dalam pengiplementasian adalah Microsoft Visual Basic 6.0

Hasil implementasi dari Game Space Wing meliputi Menu utama, Nama Pemain, Mulai,

Skor Tertinggi, Petunjuk Permainan, Profil dan Permainan Berjalan.

4.1.1 Spesifikasi Perangkat Keras dan Perangkat Lunak
Program ini dijalankan dengan menggunakan perangkat keras (hardware) yang
direkomendasikan minimal sebagai berikut :
1. Prosesor Intel Pentium TV 2.4 (zHz.
2. Memory 128 Mi
Huarddisk dengan freespace 20 MB.
VGA card 32 MB.
Monitor dengan resolusi 800 X 600 pivel.
Kevboard dan Mouse

=i R

Adapun perangkat lunak (sofiware) yang direkomendasikan untuk menjalankan
aplikasi ini adalah Microsoft Visual Basic 6.0 dengan Sistem Operasi MS-Windows
NT/2000/XP,

L
L
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4.2  Pengujian Program
Klik pada file Space Wing.cxc, maka setelah itu akan muncul tampilan Menu Utama
Space Wing.

Gambar 4.1 Tampilan Menu Utama Game Space Wing

Untuk memulai permainan klik tombol pemain, Setelah itu akan muncul Tampilan
Database Nama Pemain. Apabila anda baru ingin memulai permainan maka perlu mengisi
nama anda terlebih dahulu sehingga Nama anda tersimpan dalam database, setelah itu nama
anda akan muncul di tampilan Menu Utama, sedangkan jika anda yang ingin melanjutkan
permainan maka langsung memilih nama pemain yang tersimpan di dalam database. Setiap
nama pemain yang pernah dimasukan kedalam data nama pemain maka akan secara
olomatis tersimpan di dalam database. Database berguna untuk menyimpan semua data
permainan dari semua pemain guna untuk melihat skor tertinggi.




E‘HT'I}D 'F
ULYL

Gambar 4.3 Tampilan Nama Pemain pada Menu Utama

PN By S T e Pk T T e ey Wy

SPACE WING

(Gambar 4.4 Tampilan Melanjutkan Permainan
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Setelah nama pemain dipilih, maka langkah selanjutnya adalah memulai permainan
dengan memilih tombol Mulai pada Menu Utama. Permainan Space Wing ini terdiri dari 3
level dimana untuk setiap levelnya memiliki musuh alien dan boss yang berbeda- beda.

Untuk melanjutkan permainan ke level selanjutnya maka pemain harus
mengalahkan boss pada setiap levelnya, dan apabila boss telah dikalahkan maka secara
otomatis permainan di level tersebut berakhir yang dipastikan dengan tampilan yang
mengatakan bahwa level tersebut sefesai dan permainan dilanjutkan ke level berikutnya
hingga permainan tamat.

Gambar 4.5 Tampilan permainan level 1
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